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introducere

Acest ghid conţine un minim de cerinţe legate de tehnoredactarea diferitelor lucrări (articole, eseuri, lucrări de licenţă, disertaţii de masterat, teze de doctorat). În esenţă, acest material are la bază The Chicago Manual of Style (Staff, 2010) De asemenea, ghidul serveşte şi ca model de lucrare pentru aspecte legate de formă.

Fiecare utilizator al acestui ghid este încurajat să citească cu atenţie şi să-şi însuşească regulile pentru o tehnoredactare convenţională a lucrărilor academice din cadrul Universităţii Emanuel.

Lucrarea de licență și disertația trebuie să debuteze cu o secțiune introductivă distinctă și premergătoare capitolelor care formează structura și textul lucrării. Introducerea trebuie să se întindă pe  una - două pagini care să conțină:  (1) importanța temei tratate și motivarea alegerii ei, (2) obiectivele concrete ale lucrării și (3) o scurtă descriere a conținutului fiecărui capitol. 

Importanța și motivarea temei se poate face atât prin prezentarea unor motivații personale dar mai ales cu argumente profesionale sub forma unor date, statistici și referințe din literatura de specialitate care să susțină importanța temei. Obiectivele lucrării trebuie să fie prezentate cât mai concret posibil și să răspundă la întrebările: Ce își propune lucrarea să studieze? La ce nevoi/întrebări încearcă să găsească răspuns?”. 
1. FORMATAREA TEXTULUI

Obiectivul acestui capitol constă în prezentarea succintă dar detaliată a elementelor de formatare care se aplică textului lucrării de licență și disertației. În cadrul acestui capitol vor fi abordate aspectele privitoare atât la conținutul diferitelor părți ale lucrării ( copertă, pagina de titlu, cuprins, text principal etc.) cât și la forma de prezentare a acestora în cadrul lucrării. Orice lucrare de cercetare ştiinţifică trebuie redactată cu ajutorul calculatorului, respectiv a programelor specializate (Microsoft Office, Open Office, etc). Scrierea trebuie să se realizeze folosind toate semnele diacritice specifice limbii române. Formatul paginii este A4 (atenţie: acesta nu este setat implicit în Word!). Tipărirea lucrării se va face pe o singură faţă a foii.

1.1. Pagina de titlu

Font utilizat pentru textul de pe coperta și pagina de titlu a lucrării este Times New Roman, 
14 pt., cu excepţia titlului lucrării, care este de 26 pt. Titlul de pe coperta lucrării de licenţă sau a disertaţiei, se va scrie cu font de mărimea 26 pt. Titlul se scrie cu MAJUSCULE.

· Distanţa de la marginea de sus: 2 cm

· Distanţa dintre rânduri: 1 rând (Line spacing: single)

· Textul este aliniat la mijloc.

· În cazul în care lucrarea are un subtitlu, acesta va avea mărimea 22 pt, Small caps.
1.2. Cuprins

Cuprinsul apare la începutul lucrării, după pagina de titlu. Titlurile şi subtitlurile din cuprins sunt urmate de puncte şi apoi de numărul paginii. Numărul paginii nu este urmat de punct, „pag.” sau „pg.” Nu se va menţiona intervalul unde este situat subcapitolul în cauză (ex. Titlu........6-9.)


Distanţa dintre rânduri este de 1. Dacă titlul unui capitol sau subcapitol este mai lung de un rând, acesta se va continua de la începutul rândului următor, fiind aliniat cu prima literă a rândului anterior.


Introducerea, concluzia şi bibliografia nu se numerotează nici în cuprins (deşi apare în acesta), nici în textul lucrării. 

Cuprinsul va fi generat folosind comenzile Insert -> Reference -> Index & Tables -> Table of Contents -> Formal.
1.3. Lista figurilor

Cuprinsul va fi urmat de lista figurilor care va include titlurilor figurilor prezentate pe parcursul lucrări și pagina la care pot fi găsite acestea în textul lucrării. Formatarea acestei liste se va face ținând cont de detaliile de formatare pentru curpins. Lista figurilor va fi inserată pe o pagină distinctă.
Lista figurilor va fi generată folosind comenzile Insert -> Reference -> Index & Tables -> Table of Figures   -> Figure -> Formal.
1.4. Lista tabelelor

Lista figurilor va fi urmată de lista tabelelor care va include titlurilor figurilor prezentate pe 
parcursul lucrări și pagina la care pot fi găsite acestea în textul lucrării. Formatarea acestei liste se va face ținând cont de detaliile de formatare pentru curpins. Lista tabelelor va fi inserată pe o pagină distinctă.

Lista tabelelor va fi generată folosind comenzile Insert -> Reference -> Index & Tables -> 
Table of Figures   -> Figure -> Formal.
1.5. Textul principal
Textul principal al lucrării se va scrie folosind fontul Times New Roman, Regular de mărimea 12pt, la o distanță de 1 între rânduri și aliniere Justified. Paragrafele noi vor începe cu alineat de 0,5 cm și cu spațiere de 6pt înainte și după paragraf. Alte efecte vor fi utilizate doar pentru evidențierea elementelor speciale din text. Utilizarea diacriticelor este obligatorie. Distanța dintre titluri și text va fi de 1 rând liber. Un sumar al elementelor de formatare a textului principal este prezentat în Tabelul 1. 
Tabelul 1. Elemente de formatare a textului principal al lucrării de licență sau al disertației

	Elementul de tehnoredactare
	Caracteristici

	Fontul - tip
	Times New Roman, Regular

	Font - mărime
	12pt

	Distanță între rânduri
	1 

	Aliniere text
	Justified

	Paragraf nou - indentare
	0,5 cm

	Spațiere paragrafe
	6pt înainte și după paragraf


Sursa: Universitatea Emanuel (2019) Ghid pentru redactarea lucrărilor academice
Textul principal al lucrării de licență și disertație (fără pagina de titlu, cuprins, liste de 

tabele și figuri, bibliografie, și anexe) trebuie să fie între 20.000 și 25.000 de cuvinte ceea ce înseamnă aproximativ 40-50 de pagini la o spațiere de 1 între rânduri și o mărime a fontului de 12, așa cum se cere în prezentul ghid. 
1.6. Structura lucrării
Textul lucrării va fi împărţit în: părți, capitole, subcapitole, paragrafe, dar nu mai mult 
de 3 grade de titluri. Textul titlurilor va fi precedat de un simbol numeric, începând cu cifra 1, urmată de un punct; dacă este cazul vor urma şi alte cifre, despărţite între ele prin puncte, în funcţie de gradul titlului subordonat (ex.: 1. Capitol; 1.1. Subcapitol). 

Titlurile de gradul 1, respectiv titlurile de capitole se vor scrie cu font Times New Roman, 14p, cu litere MAJUSCULE în Bold și vor fi aliniate central. Fiecare titlul de capitol va fi inserat pe o pagină nouă și va fi urmat de un abstract, respectiv o scurtă prezentare a ideilor centrale și obiectivelor respectivului capitol urmând ca textul dezvoltat al capitolului să înceapă pe pagina următoare după cum se poate vedea în Anexa 3. Textul abstractului care urmează titlului va fi scris cu Times New Roman, Italic, 12p, spațiere de 1 rând.
Titlurile de gradul doi (2), respectiv titlurile subcapitolelor se vor scrie cu font Times 
New Roman, 12p în Bold cu litere majuscule mici (SMALL CAPS. Atenţie: folosiţi tasta SHIFT pentru a scrie cu majusculă prima literă!), iar titlul de gradul trei se scrie cu litere italice. Pentru formatarea titlurilor și subtitlurilor se recomanda setarea acestor detalii folosind funcția Styles Pane din Word astfel:
· Titlu Capitol: stilul Heading 1 (Times New Roman,  Bold,14p, MAJUSCULE, spațierea înainte de 72pt și după  de 24pt)
· Titlu Sub-capitol: stilul Heading 2 (Times New Roman, Bold, 12p, SMALL CAPS, spațierea înainte de 12pt și după de 12pt)

· Titlu sub-sub capitol : stilul Heading 3 (Times New Roman, Italics, 12p,  spațierea înainte de 12pt și după de 12pt)
Această manieră de lucru permite generarea automatizată a cuprinsului lucrării, asigură 
consecvență în formatarea titlurilor și facilitează formatarea lucrării.


Nu se pune punct după titluri; regula este valabilă şi pentru titlurile de capitole şi subcapitole; excepţie fac titlurile urmate de subtitluri (de ex.: Cognito. O introducere în teoria cunoaşterii). Dacă titlul este prea lung se aranjează pe două rânduri (cu distanţa de 1 între rânduri), rândul al doilea fiind mai scurt decât primul.  

Între două titluri de grade diferite trebuie să existe un text de minim 3 rânduri. În timp ce un subtitlu trebuie să fie urmat întotdeauna de cel puţin două rânduri de text pe aceeaşi pagină; dacă nu a rămas suficient spaţiu se va deplasa totul pe pagina următoare.


Dacă lucrarea conţine anexe, ele vor fi amplasate la sfârşitul volumului, şi nu pe capitole. Anexele trebuie să aibă titlu, iar trimiterile din text la anexe se vor face ca în cazul figurilor şi tabelelor.
1.7. Încadrarea textului în pagină


Textul să fie aliniat Justified, respectiv atât spre dreapta cât și spre stânga. Pentru tipărire se va folosi standarul A4. Zona folosită pentru tipărire nu trebuie să depășească limitele marginilor stabilite pentru margini care sunt următoarele:
· Margini (sus, jos, dreapta): 2 cm

· Margini (stânga): 3 cm.

· ”Headers and Footers”: 1 cm. La ”Header” să nu apară text (titlul lucrării, etc.).
1.8. Numerotarea paginilor


Fiecare pagină, cu excepţia celei de titlu, va fi numerotată în josul paginii cu aliniament central, cu font Times New Roman 12. Prima pagină, deşi nu este numerotată, este cea de titlu. 
1.9. Figurile și tabelele
Figurile (diagrame, grafice și imagini) și tabelele vor fi tratate ca și categorii distincte 

iar numerotarea acestora se va face separat utilizând cifrele arabe ( 1, 2, 3, ...) în ordinea lor crescătoare. Pentru orice figură și tabel inserată grafic în lucrare trebuie să existe o mențiune  scrisă în textul lucrării, de preferință cât mai aproape de locul în care apare elementul grafic. De exemplu, Figura 1 și Tabelul 2 prezintă o comparație pe ani a numărului de studenți de la Facultatea de Management. Ori de câte ori se face o referire din text la unul din acest elemente se va folosi Insert -> Reference -> Cross Reference -> Figure, respectiv Table -> Only label and number
[image: image2.emf]30

25

20

Num_r
Studen i

10

5










0

5

10

15

20

25

30

Num_r 

Studen_i

I II III IV

Anul

 Figura 1. Studenţii Facultăţii de Management
Sursa: cercetare proprie
Figurile şi tabelele trebuie delimitate de paragrafele anterioare şi ulterioare printr-o 
linie albă. Titlul figurilor trebuie să apară sub figură, iar în cazul tabelelor titlul va fi poziționat deasupra acestora. Titlurile figurilor și tabelelor se vor scrie cu font Times New Roman,11pt, Bold, centrat. Atenţie: e important ca şi textul din interiorul figurilor/tabelelor să respecte aceste cerinţe, iar raportul de detaliu a imaginii vs. informaţie oferită să fie rezonabil (proporţional cu mărimea fonturilor). Titlul unei figuri sau al unui tabel trebuie întotdeauna să apară pe aceeaşi pagină cu elemental graphic (table, figura) pe care îl descrie. De asemenea e important ca un tabel să apară în întregime pe aceeaşi pagină.
Tabelele se vor formata utilizand optiunea de formatare automata: selectati tabelul -> 
click dreapta -> auto format -> grid 1. 
Tabel 2. Studenţii Facultăţii de Management

	An
	Nr. Studenţi

2005
	Nr. Studenţi

2006
	Nr. Studenţi

2007

	I
	26
	26
	26

	II
	16
	16
	16

	III
	20
	20
	20

	IV
	23
	23
	23


Sursa: cercetare proprie
Pentru gestionarea listei de figuri (diagrame) şi tabele din lucrare folosiţi comenzile Insert -> Reference -> Caption -> Figură, respectiv Tabel.
2. citarea surselor și bibliografia
Orice lucrare academică trebuie să includă surse bibliografice care să susțină 

argumentele prezentate pe parcursul ei. Citarea surselor utilizate în cadrul lucrării, respectiv acordarea creditului cuvenit persoanelor sau organizațiilor pentru ideile acestora, reprezintă o chestiune de integritate și este obligatorie. Pe de altă parte citarea corectă a surselor bibliografice reprezintă o măsură a calității și credibilității informațiilor prezentate. Această secțiune prezintă cerințele specific referitoare la citarea surselor și alcătuirea bibliografiei lucrărilor de licență și disertație.
2.1. Referințe bibliografice în text
Orice definiție, citat, idee, concept, element statistic utilizat în textul lucrării va trebui 

susținut cu referințe bibliografice. Includerea surselor bibilografice (referințelor) în cadrul textului lucrării se va face utilizând stilul de citare Elsevier-Harvard (with titles) care se prezintă sub următorul format: (Lefter, 2004). Astfel, se va include între paranteze numele de familie al autorului urmat de virgulă și anul publicării articolului/cărții/documentului. În cazul în care o sursă bibliografică are până la trei (3) autori se vor include în paranteză numele de familie al fiecăruia dintre aceștia urmate de anul publicației (Sherman, Sperry și Reese, 2003). Atunci când o sursă bibliografică are mai mult de trei autori citarea ei în textul lucrării se va face prin includerea numelui de familie a primului autor/coordinator urmat de sintagma “et. al” (Pop et. al, 2002). Mai multe detalii despre cum se utilizează stilul de citare Elsevier-Harvard (with titles) pot fi găsite accesând acest link https://citationsy.com/styles/elsevier-harvard. 
Nu se vor utiliza notele de subsol pentru citarea în cadrul textului a surselor 
bibliografice decât în cazuri excepționale în care se dorește explicarea/exemplificarea unui termen făra ca aceasta (exemplificare/explicare) să fie inclusă în text.  
Pentru managementul citărilor și crearea bibliografiei se recomandă utilizarea 
programului Zotero https://www.zotero.org/ care facilitează și automatizează aceste procese. Acest program permite realizarea citărilor și a bibliografiei în mai multe stiluri și de asemenea schimbarea stilului citărilor cu un singur click. Pentru a respecta stilul de citare indicat Elsevier-Harvard (with titles) este important ca acesta să fie încărcat în programul Zotero urmând acest link https://www.zotero.org/styles.
Figura 2. Identificarea și încărcarea unui stil de citare în Zotero
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Zotero Style Repository
Here you can find Citation Style Language 1.0.1 citation styles for use with Zotero and other CSL 1.0.1-compatible software. For more information on using CSL styles with Zotero, see the
Zotero wiki.

Style Search Format: | author-date | | numeric

Fields: (biology )  generic-base

Show only unique styles

8 styles found:

« Elsevier - Harvard (with titles) ~ (2019-01-22 15:57:12)

* Elsevier - Harvard (without titles) ~ (2017-05-18 15:23:08)
« Elsevier - H; 2 (20170518 15:23:08) Lk Sowre
« Elsevier - Vancouver ~(2017-05-18 15:23:08)

Elsevier - Vancouver (author-date)  (2017-07-09 22:44:59)
* Elsevier (numeric, with titles, sorted alphabetically) ~ (2016-04-2115:20:00)
Elsevier (numeric, with titles) ~(2016-04-2115:20:00)

Elsevier (numeric, without titles) ~ (2018-05-10 03:59:38)




Sursa: Zotero Style Repository

2.1.1. Citate


Citatele cu margini (cele care au trei sau mai multe rânduri) se vor scrie cu font de 11 pt. si cu spaţiul între rânduri de 1. În acest caz nu se vor folosi ghilimele. Distanţa textului din citat faţă de margine: marginea din stânga la 0,5 cm faţă de textul principal. Se lasă un rând liber între citat şi textul principal – şi înainte şi după citat. Citatul poate continua pe pagina următoare, singura condiţie este să nu apară rânduri orfane. 
Citatele care se întind pe mai puțin de 3 rânduri se vor pune între ghilimele în cadrul 
propozițiilor și frazelor fără a le delimita de textul principal. În cazul unui citat între ghilimele, dacă punctul de la sfârşitul enunţului citat face parte din textul citat, se trece înaintea ghilimelei de încheiere, nu după ea.

Exemplul 1: Citat între ghilimele (mai puţin de 3 rânduri)

...in such a way that they are all part of what Schillebeeckx calls “the history of the authenticity of Christian faith within the life of religious mankind.” (Nemati et al. 2002) Therefore, if there is any difference at all between the non-scientific religious experiences of the traditional past and the scientific religious experiences of the modern present, that difference is only in... 

Exemplul 2: Citatele cu margini fără ghilimele (trei sau mai multe rânduri, cu margini de 0,5 cm la stânga faţă de textul principal).
	Thus, he strongly believes that the modern man needs to find a way to make his life meaningful exclusively in terms of the modern science which dominates our secularized world:

The criticism of the traditional way of speaking of God which is now being voice within the Christian churches, both Protestant and Catholic, arises, on the one hand, from the deepest values which these churches really aim to embody and, on the other hand, from the new, rational and secular sphere of understanding within which people are now seeking a meaning for human life. (Nemati et al. 2002)
Schillebeeck is so preoccupied to see Christian theology turn its traditional clothing into modern garments that he loses sight of the fact that the meaning of life may well go beyond a merely and purely scientific approach to life.


2.2.  Bibliografie
Bibliografia trebuie să conțină un minim de 40 referințe bibliografice unice, care să fie 
echilibrate din punct de vedere a perioadei publicării lor (cel puțin o treime din ultimii 5 ani), să reprezinte atât surse academice cât și publicații popular business (ex. Harvard Business Review, The Economist) și de asemenea să fie echilibrate între cărți și articole de specialitate. Pentru găsirea celor mai potrivite articole academice de specialitate accesați gratuit baza de date ANELIS http://www.emanuel.ro/cercetare-ueo/e-journals/ și Google Scholar. Opiniile personale de pe bloguri nu reprezintă bibliografie acceptabilă, decât cu titlu de excepție atunci când subiectul studiat este foarte recent, iar blogerul respectiv este originatorul/ creatorul conceptului/ ideii/ trendului.
Listarea bibliografiei se face la finalul lucrării în ordinea alfabetică a numelui de 
familie a primului autor cu font Times New Roman, 11pt, cu distanța de 1 între rânduri și spațiere de 6pt între două intrări bibliografice. În bibliografie vor fi incluse doar sursele care au fost citate în cadrul lucrării. De asemenea este foarte important ca detaliile care descriu sursa utilizată să fie cât mai complete. În cazul în care anumite date lipsesc sau nu pot fi găsite se vor utiliza următoarele abrevieri: „f.a.” (fără anul publicării), „f.l.” (fără locul publicării), „f.e.” (fără numele editurii). Aceasta numai dacă într-adevăr nu s-au găsit datele respective şi nu pentru a compensa comoditatea studentului. 
Pentru generarea și gestionarea bibliografiei se recomandă utilizarea programului 

Zotero sau a opțiunilor implicite din programul Microsoft Word. Formatarea bibliografiei se va face, la fel ca și în cazul citărilor în textul lucrării, conform stilului Elsevier-Harvard (with titles) https://citationsy.com/styles/elsevier-harvard.
În funcţie de tipul sursei menţionate (carte, articol, sursă internet), ordinea datelor care 

trebuie incluse în bibliografie pentru identificarea respectivei surse diferă. Următoarele sunt exemple de intrări bibliografice conform stilului Elsevier-Harvard ( with titles) pentru diferitele categorii de surse care pot fi întâlnite:
Articol în jurnal
	Format
	Numele autorului, Inițiala/ele prenumelui., anul publicației. Titlul articolului. Titlul jurnalului în care apare articolul, Numărul volumului jurnalului, Intervalul de pagini între care apare articolul respectiv în jurnal. https://doi.org/DOI  
În cazul în care articolul are mai mulți autori se vor include numele de familie și inițiala prenumelui tuturor autorilor.

Author1 LastnameA.F., Author3 LastnameA.F., 2000. Title. Container Volume, pages Used. https://doi.org/DOI


	Exemplu
	Petit, C., Sieffermann, J., 2007. Testing consumer preferences for iced-coffee: Does the drinking environment have any influence? 18, 161-172. https://doi.org/10.1016/j.foodqual.2006.05.008


Carte

	Format
	Numele autorului, Inițiala/ele prenumelui., anul publicării. Titlul cărţii. Numele editurii, Orașul 

	Exemplu
	Rowling, J.K., 1997. Harry Potter and the Philosopher’s Stone, 1st ed. Bloomsbury Publishing Inc, London.


Capitol în carte
	Format
	Numele autorului, Inițiala/ele prenumelui., anul publicării. Titlul capitolului, în: Titlul cărții, Numele editurii, Orașul, Intervalul de pagini între care apare capitolul respectiv în carte.

	Exemplu
	Krautkraemer, J., 2005. Economics of Natural Resource Scarcity: The State of the Debate, Oxford University press, Oxford, 120-140.


Website
	Format
	Numele autorului, Inițiala/ele prenumelui., anul publicării. Titlul [WWW Document]. URL https://www.exemplu.com (accesat 2.11.2018).

	Exemplu
	Tran, M., 2008. Barack Obama To Be America’s First Black President [WWW Document]. URL https://www.theguardian.com/world/2008/nov/05/uselections20083 (accesat 2.11.2019).


În cazul sursei de internet, dacă nu există anumite date (locul publicării, numele editurii 
etc.) se specifică doar datele disponibile. Sursele de internet să nu depăşească 25% din totalul surselor bibliografice.

3. Cerinţe de scriere şi predare a lucrărilor
Această secțiune detaliază cerințele referitoare la scrierea și predarea lucrărilor. Se recomandă studentului să țină legătura permanent cu secretariatul facultății pentru a afla dacă au survenit modificări în orarul sau dosarul de predare a lucrărilor. De asemenea se recomandă ca studentul să țină o strânsă legătură cu cadrul didactic coordonator pe tot parcursul procesului scrierii, predării și susținerii lucrării pentru a beneficia de ghidare și sfătuire. 
3.1. Număr de cuvinte şi intrări bibliografice
3.1.1.  Observaţii ortografice

Pauza: a nu se folosi înainte, ci după (.), (,), (:), (;), (!), (?). În cazul citatelor sub trei rânduri (adică unde se folosesc ghilimele), pauza se foloseşte înaintea ghilimelelor de la începutul citatului, nu după acestea, iar în cazul ghilimelelor de la sfârşitul citatului pauza se foloseşte după, nu înaintea ghilimelelor. Aceeaşi regulă este valabilă în cazul parantezelor.

Atenţie! A nu se folosi pauza dublă.
Cerințele privind dimensiunea lucrării și numărul minim de intrări bibliografice sunt

prezentate sistematic în tabelul 3.
Tabel 3. Cerințe privind numărul de cuvinte și intrări bibliografice
	Tipul de lucrare
	Număr de cuvinte (exclusiv bibliografia)
	Număr minim de intrări bibliografice

	Lucrare de licenţă
	20.000-25.000
	40-50

	Disertaţie de masterat
	20.000-25.000
	40-50

	Teză de doctorat
	80.000-100.000
	300

	Eseuri, lucrări de seminar
	Numărul de cuvinte şi de intrări bibliografice este stabilit de profesor. La numărul de cuvinte se acceptă o abatere de 20%. 


Sursa: Universitatea Emanuel (2019)
3.2. Mod de predare al lucrărilor de licenţă, disertaţiilor şi tezelor

Studentul poartă toată responsabilitatea pentru calitatea, integritatea și autenticitatea 
lucrării sale în momentul predării acesteia la secretariatul facultății. Atenție! Toate lucrările predate la secretariatul facultății vor fi testate cu un soft specializat anti-plagiat. Premergător predării lucrării de licență sau disertație studentul are posibilitatea de a-și verifica lucrarea folosind același soft anti-plagiat pe care îl poate accesa la Biblioteca Universității Emanuel. În felul acesta pot fi corectate și evitate eventualele similitudini cu alte lucrări/publicații pe care softul le analizează și care au fost utilizate ca surse în cadrul lucrării.
Lucrările de licență și disertație se vor preda la secretariatul facultăţii înainte de data-
limită stabilită. Predarea lucrării implică următoarele elemente:
· O copie tipărită şi legată cu copertă tare.
· Un CD cu lucrarea (licența, disertaţia, teza) în format MS-Word, extensia rtf (Rich Text Format) şi în format pdf. Numele documentului electronic să nu conţină diacritice.

· Întreaga lucrare să apară într-un singur document (nu împărţită pe capitole, sau pagina de titlu separată!). 

· Declaraţia de autenticitate a lucrării de finalizare a studiilor (vezi formatul ei în Anexa 5), completată şi semnată de către absolvent, constituie ultima pagină a lucrării.  
· După cum reiese din Orarul Lucrărilor de Licență, Disertațiilor și Tezelor, lucrarea trebuie predată fiecărui membru al comisiei de examinare. Aceasta este responsabilitatea autorului lucrării. Lista comisiei de examinare se găsește la secretariatul facultății. 
· Nu se acceptă lucrări în forma finală după termenul stabilit în Orarul Lucrărilor de Licență, Disertațiilor și Tezelor.
3.3. Orarul lucrărilor de licenţă, disertaţiilor şi tezelor
	Pas
	Activitate
	Termen limită

	1.
	Selectarea tematicii lucrării
	4 Noiembrie

	2.
	Definitivarea structurii lucrării
	9 Decembrie

	3.
	Raport de progres*
	31 Martie

	4.
	Predarea lucrării pentru revizuire finală de către coordonator
	

	5.
	Predarea lucrării la secretariatul facultății
	17 – 28 Iunie

	6.
	Susținerea orală a lucrării
	1 – 6 Iulie


*  Raportul de progres presupune  atât încărcarea pe platforma google classroom in cadrul  cursului  elaborare lucrări de licență  cât și transmiterea către coordonator a  primei jumătăți a lucrării.
Anexa 1: Model copertă pentru lucrări de licenţă, disertaţii, teze

R O M Â N I A 

ministerul educaţiei naționale

universitatea „emanuel” din oradea

facultatea de management

LUCRARE DE LICENŢĂ
Absolvent:

Prenumele Numele Studentului

Coordonator (i):

Titlul academic (ex. Conf. Univ. Dr.) Prenumele Numele Coordonatorului
Oradea, 2019
Anexa 2: Model PAGINĂ DE TITUL ( ACEASTA APARE ÎN INTERIOR) pentru lucrări de licenţă, disertaţii, teze

R O M Â N I A 

ministerul educaţiei naționale

universitatea „emanuel” din oradea

facultatea de management

titlul lucrĂrii
Subtitlu

Absolvent:

Prenumele Numele Studentului

Coordonator (i):

Titlul academic (ex. Conf. Univ. Dr.) Prenumele Numele Coordonatorului
Oradea, 2019

Anexa 3: ÎNCEPEREA UNUI CAPITOL NOU

1. PRIMUL CAPITOL
Fiecare început de capitol trebuie să conţină un abstract: o scurtă prezentare a ideilor centrale şi a obiectivelor respectivului capitol. Textul acestui abstract va fi formatat după aceleași detalii aplicate formatării textului principal (Times New Roman, 12p, 1 rând) cu distincţia că scrisul va fi cursiv (italic).

Textul dezvoltat al capitolului va începe pe pagina următoare.
ANEXA 4: câteva probleme de conţinut recurente

       1. Folosirea persoanei întâi (singular şi plural) să se limiteze la introducere şi  

concluzii. Nu se foloseşte persoana a doua. Recomandăm folosirea persoanei a III-a singular la modul impersonal (Ex. „se ştie că...”, „se observă că..,” „în acest capitol va fi analizat...”)

2. Denumirea popoarelor şi religiilor se scrie cu literă mică (amoniţi, nu Amoniţi; evrei, nu Evrei; baptişti, nu Baptişti), exceptând cazul în care aceste denumiri stau la începutul propoziţiei. 


3. Un paragraf să conţină cel puţin două enunţuri ample (un enunţ amplu să fie de maximum trei rânduri). Propoziţiile şi paragrafele lungi ar trebui evitate. Un subcapitol ar trebui să conţină cel puţin două paragrafe.


4. A se evita rândurile orfane şi văduve, adică: ultimul paragraf din pagină să nu aibă doar un rând la sfârşitul paginii sau ultimul paragraf din pagină să nu se continue pe pagina următoare doar cu un rând. 


5. A se evita verbele legate de vedere. Exemplu: „În acest capitol vom privi la unele aspecte... Am observat că aspectul teologic... Din acest exemplu se vede că... Acum ne vom uita cu atenţie la...” 


6. Evitarea verbului a putea. „În concluzie putem vedea că... De aceea putem spune că...”


7. Evitarea colocvialismului. „Setea ca setea, dar israeliţilor li s-a făcut foame!” „Cu două capitole mai încolo...”, „Culmea este că poporul...”, „Interesant este faptul că...”


8. Capitolele să fie echilibrate din punctul de vedere al volumului. O lucrare este lipsită de echilibru dacă un capitol are două pagini, iar un alt capitol are douăsprezece pagini. 

9. La pagina de titlu se scrie întotdeauna numele curent al ministerului. Este recomandat ca înainte de tipărirea lucrării studentul să verifice la secretariat denumirea ministerului educației pentru a afla dacă au survenit modificări.
      10. Un cadru didactic nu are în mod automat titlul academic de “Profesor” deși în mod colocvial cadrele didactice, chiar și cele din învățământul gimnazial și liceal, sunt numite generic “professor/profesoară”. Titlul academic corect al cadrului didactic coordonator se poate afla la secretariatul facultății. 
Anexa 5: câteva probleme de formă recurente

1. A nu se folosi spaţiile multiple, atât între cuvinte cât şi pentru aliniere! Pentru eliminarea acestora folosiţi comanda CTRL+H, „Find and Replace”: căutaţi spaţii duble şi înlocuiţi cu un singur spaţiu.


2. Verificaţi formatul paginii înainte de a începe să scrieţi lucrarea! Pentru Word 97-2003, XP, urmaţi calea: File – Page Setup – Paper; mărimea paginii să fie A4. Pentru Word 2007-2010: Page Layout – Size.


3. Verificaţi dimensiunile marginilor! Pentru Word 97-2003, XP, urmaţi calea: File – Page Setup – Margins; stânga: 3 cm, în rest 2 cm. Dacă unitatea de măsură este în inch o puteţi schimba urmând paşii: Tools – Options – General; la „Measurement units” selectaţi „centimeters”. Pentru Word 2007-2010 în meniul Page Layout – Margins – Custom Margins.


4. Pagina de titlu nu se numerotează! Pentru Word 97-2003, XP urmaţi paşii: File – Page Setup – Layout; selectaţi opţiunea „Different first page”, OK. Când faceţi numerotarea paginilor, să vă asiguraţi că opţiunea „Show number on first page” nu este bifată. Pentru Word 2007-2010, intraţi în Footer-ul paginii, apoi în meniul Design selectaţi opţiunea „Different first page”; asiguraţi-vă că opţiunea „Link with previous” este deselectată; dacă totuşi, după ce inseraţi numerotarea, apare număr pe prima pagină, ştergeţi-l.


5. Rândurile libere între paragrafe nu sunt permise decât în cazul citatelor! Dacă observaţi că atunci când începeţi să scrieţi un paragraf nou rândul se distanţează neobişnuit în mod automat, urmaţi paşii: pentru Word 97-2003, XP, în meniul Format – Paragraph, la secţiunea „Spacing”, Before şi After trebuie să aibă valoarea 0.


7. Cuprinsul se generează automat! Folosiţi pentru Word 2007-2010 paşii următori: References – Table of Contents – Insert Table of Contents. La ”Show Levels” selectaţi valoarea 2. Pentru utilizatorii Template-ului: apăsaţi butonul ”Options” şi în lista care va apare introduceţi următoarele valori: pentru ”Introducere şi alte titluri” = 1; ”Capitol” = 1; ”Subcapitol de grad 1” = 2; ”Subcapitol de grad 2” = 3. OK.


Pentru Word 2000-2003 şi XP urmaţi paşii următori: Insert – Reference – Index and Tables – Table of Contents. Urmaţi apoi aceleaşi instrucţiuni prezentate mai sus.

Anexa 6: Declaraţia de autenticitate a lucrării de finalizare a studiilor

UNIVERSITATEA EMANUEL DIN ORADEA

FACULTATEA DE  …………..              








































DECLARAȚIE DE AUTENTICITATE A LUCRĂRII DE FINALIZARE A STUDIILOR

Titlul lucrării ……………………….

Subsemnatul(a) ………………………………………..,

absolvent(ă) al(a) Universităţii Emanuel din Oradea, Facultatea de ……., 

programul de studii universitare de ………. în specializarea ……………., 

declar pe proprie răspundere că lucrarea de faţă este rezultatul muncii mele, pe baza cercetărilor mele şi pe baza informaţiilor obţinute din surse care au fost citate şi indicate, conform normelor academice, în note şi în bibliografie. Lucrarea nu conţine porţiuni plagiate, iar sursele bibliografice au fost folosite cu respectarea legislaţiei române şi a convenţiilor internaţionale privind drepturile de autor. 
Declar că lucrarea nu a mai fost prezentată, sub această formă, în alte contexte de examen sau de concurs.
  

Oradea, _______________




Semnătura,

2

